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2. Features

TR-102 is a personal remote positioning device with built-in GPS and GSM modules; it’s compact and portable. Not only can 
TR-102 transmit the longitude and latitude coordinate to your cell phone by the short message service, but it can also transmit 
the longitude and latitude coordinate to your personal computer by the internet connection of GPRS and then displaying the 
location by a specific map software. There are three speed-dial keys and one emergency key on the TR-102. You can use 
these features for protecting and searching children and old persons. Further, you can use it as a security purpose and other 
purpose which needs remote positioning. 

1. Introduction

1. GPS/GPRS personal locator. 
2. GSM/SMS/GPRS communication. 
3. Omni-directional high sensitivity GPS antenna which can receive GPS signal from all direction. 
4. New technology and latest GPS SiRF-Star III chipset! Excellent for fixing the position even at a weak signal status. 
5. Remote command control via mobile phones or through online software. 
6. Receive phone calls to have two way communications. 
7. Monitors can track the person without interfering him, LIVE! Real-Time tracking!
8. Locate the locator holder by just pressing a button on PC software or through mobile phone via SMS (short messaging 

system). 
9. Three quick dialing buttons for 3 preset phone numbers. 
10. Works worldwide! Support 4-frequency GSM 850/900/1800/1900 MHZ and GPRS class 12. 
11. SOS button send out exact location for immediate rescue/action. 
12. Independent SOS (emergency) button which will send GPS location information via SMS for up to 3 preset numbers (it 

can be 3 sets of different numbers than the 3 sets of quick dialing numbers). 
13. Device can be connecting to PC by using a USB cable for setup the arguments (package comes with mini USB cable 

when you purchase the device). 
14. Report device holder’s position at a preset time interval. 
15. Low battery notification before the battery dies out! Worrying free on why the locator wouldn’t respond for this kind of 

situation! 



�

 TR-102

�

TR-102   

Software Feature 
Professional Call Center program, supporting the operating system such as Windows 98 /2000 /XP, also supporting up to 5 
sets of TR-102's tracking function at the same time by using the GPRS mode. Clicking on one of the TR-102's user name from 
the Call Center program will open a browser with the latitude and longitude information displaying as a point at the center of 
the maps.google.com. The display map is Google's patented right.

3. Specification

GSM module: embedded GSM 850/900/1800/1900 MHz , GPRS class 12

GPS Chipset: SiRF Star III

Frequency: L1, 1575.42 MHz
C/A code: 1.023 MHz chip rate
Channels: 20 channel all-in-view tracking
Antenna Type: Omni-directional GPS antenna
Position Accuracy: 10 meters, 2D RMS

Velocity Accuracy: 0.1 m/s
Time Accuracy: 1 us synchronized to GPS time
Default datum: WGS-84
Reacquisition: 0.1 sec., average
Hot start: 1 sec., average
Warm start: 38 sec., average

Hardware
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Cold start: 42 sec., average
Altitude Limit: 18,000 meters (60,000 feet) max.
Velocity Limit: 515 meters/second (1000 knots) max.
Acceleration Limit: Less than 4g
Jerk Limit: 20 m/sec3
Operating temperature: -20° to 55° C
Humidity: 5% to 95% Non-condensing
Dimension: 115 mm × 45 mm × 22.5 mm
Voltage: Rechargeable and replaceable 1300 mAh battery (3.7V), 5V for charging input.
Charging connector: DC 5V
Standby time: Over 100 hours
Talking time: 5 ~ 6 hours
LED: 3 LEDs showing Power, GPS and GSM status.
Key: 7 Keys for Power On/Off key, Emergency key, Intimate call * 3, Lock key and Answer/

Reject key.
USB port: Mini USB port for connecting to PC.
SAR: GSM850 Head: 0.758 

PCS1900 Head: 0.735 
GSM850 Body: 0.21 
PCS1900 Body: 0.223 
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4. Start-up

4.1 Accessories
1. TR-102

2. 1300 mAh Li-ion Battery

3. Mini USB cable

4. AC power adapter

5. CD-ROM

1 2 3

4 5

Li-lon Battery
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4.2 Charging the battery
Before you can use the TR-102, you must complete the following procedures:

1. Fully charge the battery.  Before your first time using of TR-102, please connect it with AC power adapter for battery charging at least 

10 hours under the power-off condition. (The included battery is specially designed for TR-102. Please do not use other type of battery; 

otherwise it will damage the device. If you need to change the battery for TR-102, please contact you local dealer.)

2. Install the SIM card. Please see the steps below in this page.

3. Complete the software setup. Please refer to chapter 6 for details.

Install SIM card:

1. Press on the battery cover, and then pull it downward to open it. 

2. Remove the battery. 

3. Insert the SIM card into the cartridge according to the direction shown, and close the cartridge when done.

4. Put back the battery, and close the battery cover.

4.3 Install SIM card 
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5.1 Appearance

5. Hardware Overview

D
C

Answer / Hang up 

Quick dial 1 / Volume up

Quick dial 2 / Mute the microphone

Quick dial 3 / Volume down

SOS button

Power button

Power LED
GPS LED
GSM LED

Speaker

Microphone

Power adapter jack

Mini USB connector

Button Lock
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Power button Turn on / Turn off: Please see 7.1 for details.

SOS button You can assign up to 3 sets of phone numbers to the SOS button. When this button is pressed, TR-102 will send 
its location information to these 3 sets of phone numbers by SMS.
TR-102 will first call the SOS number 1 and send the location information by SMS.  Following, TR-102 will repeat 
the same procedure to SOS number 2 and 3.

Answer / Hang up When there is an incoming call, press this button to answer the incoming call. While in talking, press it will hang 
up the phone.

Quick dial 1 / Volume up You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number. 
While in talking, you can press this button to increase the volume.

Quick dial 2 / Mute the 
microphone

You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number. 
While in talking, the other party will not hear from you if this button is pressed to mute the microphone; press it 
again to enable the microphone. 

Quick dial 3 / Volume 
down

You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number. 
While in talking, you can press this button to decrease the volume.

GSM LED LED is on: TR-102 is turned on, but not connected to GSM network yet.
Blinking quickly (once per second): TR-102 is in dialing or talking mode.
Blinking slowly (once per 3 seconds): TR-102 is in the standby mode.

GPS LED The LED will be blinking when TR-102 is fixing its location. More details please see Page 21 for SOS button and  
Page 27 for GPRS mode.

Power LED The LED will be orange when AC adapter is plugged for charging the battery. If the battery power is low, this LED 
will be on in red.

Power adapter jack Plug in the Power adapter to TR-102's power adapter jack for battery charging.

Mini USB connector Connecting TR-102 to PC by a Mini USB cable, you can setup all its features and functions from application 
software in PC.

Button Lock Switch to lock all the buttons for the purpose of preventing buttons from been accidentally touched. (Only the 
power button is not lockable. When Button Lock is on, the LED indicators will flash 3 times if any other button is 
pressed.) 

5.2 Button description
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6. TR-102 Setup and Call Center Operation

1. Insert the CD into CD-ROM drive. When the autorun dialog box is displayed, 

click on "Install USB Driver" button to install the TR-102 driver. 

2. You will see dialog box 1, click on Next to continue.

3. When installation is complete, click on Finish to close the dialog box 2.

4. Reboot your PC to activate the USB driver.

6.1 Install the USB driver

Dialog box 1

Dialog box 2Autorun Dialog box
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6.2 Install the Call Center program

1. From the autorun dialog box, click on the "Install PC Software" to install the 

Call Center program. 

2. Follow instruction of dialog box 1 to continue the installation.

3. When the installation is complete, click on Finish in dialog box 2 to close 

the dialog box.

Dialog box 1

Dialog box 2Autorun Dialog box
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6.3 Call Center Operation

Menu item Icon button Description
File > Save File (KML) Save the records as the KML format. You can import the KML file to Google Earth, 

and it will display the location route. This function only works under the "Search 
Records" mode.

File > Exit Close the Call Center program.

View > GPRS Tracking Switch to GRPS Tracking mode. You can view the information of TR-102 which is 
on line. 

View > Show Map Check this item to show the location point in Google Map or Google Earth.

View > Search Records Switch to Search Records mode. You can inquire information of one user during 
a specific time. When you double click on one of these items, it will show the 
location point of this item on Google Map or Google Earth.

Management > User Information Display the User Information. You can setup up to 5 users in the Call Center.

Management > User Edit For deleting a user. The Call Center can only hold 5 users’ information at most. If 
you want to add a new user after you have already set 5 users, please delete a 
existing one first.

Management > Setup When a TR-102 is connected to your PC, you can do the basic setup to this TR-
102.

GPRS > Start Start the Call Center connection to Internet. You can send the commands to TR-

102 if the Call Center is connected online.

GPRS > Pause Pause the Call Center connection from Internet.  While your Call Center is online, 

you can not enter the setup mode unless you pause the connection first. 

GPRS > Send Command to RT102 Send Command to TR-102

Map > Google Map Set to display the location point by "Google Map".

Map > Google Earth Set to display the location point by "Google Earth". 

About Version information. 
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6.4 Basic Setting

1. Connect the USB cable to TR-102 and the PC's USB port after installing the driver.

2. Turn on the power of TR-102: 

(i) Please wait for a while until the startup process is finished. 

(ii) Press and hold the "Answer/Hang up" button about 5 seconds until you see the three LEDs 

flashing slowly and simultaneously. Release the button and it will enter the setup mode.

3. Start the TR-102 Call Center program in your PC (or double click on the "TR102-Call Center icon 

from desktop).

4. Click Management > Setup in menu item, then press on the Scan button to scan the COM port 

which TR-102 is connected. (Figure 1) When the scan process is finished, click on OK and it will 

automatically set the correct COM Port.

5. Press on the Setup button (Figure 2) to open the setup dialog box.

6. For detailed description of those setting, please refer to the following pages. 

Note:  If your SIM card has the PIN code protected, a 
dialog box will pop up first to ask you to enter the PIN.  

Be careful when you enter the PIN code. Normally, if you 

enter the wrong code for 3 times, the SIM card will be 

locked. If you do not know the PIN code or it has been 

locked, please consult with your SIM card provider. 

Figure 1

Figure 2
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item option description
Return Type GPRS TR-102 will return the location information by GPRS.

SMS TR-102 will return the location information by SMS.
Answer Mode Off TR-102 will not ring and user can not answer the call. 

When received a call or SMS, TR-102 will return the location information by the way of "Return 
Type".  (please see figure. 3 in page 32)

On When received a call, TR-102 will ring, and user can answer the call. (please see figure. 1 in 
page 32)
When received a SMS, TR-102 will return the location information by the way of "Return Type". 
(please see figure. 2 in page 32)

Return count 1~10 Set the time period in minute for GPS fixing.
Check Phone 
List

Off TR-102 will return the location information for all the incoming call.
On TR-102 will return the location information only if the number of incoming call is from the Check 

Phone List.
Time Zone On The SMS returned by TR-102 will contain a local time.

Off The SMS returned by TR-102 will contain a Coordinated Universal Time, abbreviated UTC. 
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Note: 
	 The returned SMS from TR-102 to your mobile phone will be the following format: (example)

Position Report:

TR102

2005/01/02 11:20:30

24.9965,121.4877

GPS fixed

	 • The second line shows your User Name (default is "TR102").
	 • The third line contains the date and time. (yyyy/mm/dd hh:mm:ss)
	 • The fourth line contains the longitude and latitude. You can copy this value and input it to "Google Earth" or maps.google.

com to find this position on map.
	• The fifth line indicates "GPS fixed" or "GPS not fixed". (If it is "GPS not fixed", then the information of third and fourth 

lines will be the one from last time GPS fixed.)

item description
SOS 
Number 
1~3

When SOS button is pressed, TR-
102 will dial to these 3 numbers 
and send the location information 
to them by SMS.  (please see 
figure. 4 in page 33)

Quick Dial 
1~3

Assign numbers to Quick Dial 
button 1~3 respectively. (please 
see figure. 5 in page 33)
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item description
Phone Number 
1~3

These 3 numbers are same as 
Quick Dial number, you can 
not modify it from here.

Phone Number 
4~10

You can set number 4 ~ 10.

item description

IMEI International Mobile Equipment 
Identity

Firmware 
Version

Firmware version of TR-102

Name Input a user name here. (Default is 
TR102)

Phone Input the phone number of  th is 
TR-102.
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item description

GPRS user name Please consult your 
Call Center system 
administrator for 
all other parameter 
values.

GPRS user password

GPRS apn

GPRS_dns1

GPRS_dns2

item description

GPRS Port Default GPRS Port is 
"5000".

GPRS Server Host 

Name
Set the GPRS server 
host name.
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7. Operating the device

7.1 Turn on / Turn off

7.2 Answer / Hand up the phone

● When there is an incoming call, press this button to answer the 
incoming call. 

● While in talking, press it will hang up the phone.

● Turn on: When the device is off, press the Power button for 3 seconds, 
three LEDs will start to flash quickly from top to bottom. It will enter the 
standby mode with blue LED flash slowly after the startup process is 
finished. (During the startup process, it can not be turned off.) When the 
device is on, GPS will start to locate its position with the green GPS LED 
flashing. If location is fixed, the LED will be on for a few seconds and 
then goes out. If the location is not fixed in 3 minutes, the GPS function 
goes sleep mode for 30 minutes before its next trial. It is suggested that 
you be a outer place where it can receive the better GPS signal when 
you turn on the device.

● Turn off: When the device is on, press the Power button for 3 seconds, 
three LEDs will start to flash slowly from bottom to top. When the LEDs 
go out, it indicates that the device is turned off for sure.  
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7.3 Adjust the volume

● While in talking, you can press the "+" button to increase the volume.
● While in talking, the other party will not hear from you if the mute 

button is pressed to mute the microphone; press it again to enable the 
microphone. 

● While in talking, you can press the "-" button to decrease the volume.

7.4 Making a phone call

● If you have already setup the Quick dial number, then you can press 
the Quick dial button to make a call to the preset number. 
If you want to press the button to make a quick dial , please press the 
button for over 1 second and release.  

Quick dial 1

Quick dial 2

Quick dial 3
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7.5 Send out emergency SMS

● 	If you have already assigned 3 sets of phone numbers to the SOS 
button, press this button on the TR-102 will send out its location 
information to these 3 sets of phone numbers by SMS. 
To avoid accidentally touching of this button, when you want to send 
out the emergency SMS, please make sure you press this button for 
over 2 seconds and release. 

● 	TR-102 will first call the SOS number 1 and send the location 
information by SMS.  Following, TR-102 will repeat the same 
procedure to SOS number 2 and 3.

 How does it work when you press the SOS button?
1. To confirm that you have pressed SOS button correctly, TR-102 will followed by long flash the red LED about 2 times.
2. TR-102 will start to position itself with green GPS LED flashing; when the GPS position is fixed, the LED will be on.  
3. Then, TR-102 will turn off GPS and green LED goes out. 
4. TR-102 begins to send SMS with blue LED flash once per second.
5. When it finished sending SMS, the blue LED comes back to standby mode with flash once per three seconds.
6. If the SMS has been sent out successfully, TR-102 will again long flash the red LED about 2 times.
7. If the GPS position can not be fixed for 3 minutes, it will send back the SMS with a "no fixed" message and the last fixed position.
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8. Tracking by SMS mode 
8.1 Setup SMS return type

8.2 Send SMS from a cell phone to TR-102

8.3 TR-102 sends SMS to cell phone

•  Connect the USB cable to TR-102 and 
the PC's USB port. 

•  Enter the setup mode. Select "SMS" 
Return Type from "Phone Mode" tab.

•  Send a short message to TR-102 to trigger it for sending back the location information. (The message 
content can be anything, even a blank message.)

•  When TR-102 receives a short message, it will return the location information by SMS in the following 
format.

Position Report:

TR102

2005/01/02 11:20:30

24.9965,121.4877

GPS fixed
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8.4 Displaying the location on map
● 	Start the Google Earth software. (For more information about the Google Earth software, please refer to “TR-102 

Supporting User Manual En_Free Google Earth Software.pdf” which you can find them in the CD-ROM under the 
“Manual” folder.)

Input the latitude and 
longitude that you 
received from SMS and 
click on search button. 

The Google Earth will 
display the location map 
for you. 
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● 	Or you can start the Internet Explorer and type "http://maps.google.com" to connect to Google Map website for displaying 
the location map.  

Select "Satellite" or "Hybrid". It 
depends on Google Map whether your 
area is supported by this mode or not.

Input the latitude and longitude that 
you received from SMS and click on 
Search button. 

The Google Map will display the 
location map for you. 
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9. Tracking by GPRS mode 
9.1 Setup GPRS return type

• Connect the USB cable to TR-102 and the 
PC's USB port. 

• Enter the setup mode. Select "GPRS" 
Return Type from "Phone Mode" tab.

9.2 Trigger the TR-102 to connect to Internet by GPRS
• If the Answer Mode is "Off", you can use the cell phone to call TR-102, or send a short message to TR-

102 to trigger it for connecting to internet.
• If the Answer Mode is "On", you can only send a short message to TR-102 to trigger it for connecting 

to internet.
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9.3 Send a command from Call Center to TR-102
• You can send command to TR-102 by the following steps and make it send back the location 

information:
(1) Start the TR-102 Call Center program and click on "GPRS" > "Start" from menu bar to start the 

connection for internet.
(2) Click on "GPRS" > "Send Message" to display the Send Message box.
(3) Select the Name, Return Mode, and Second if necessary. Click on OK button to send out this 

command.
(4) Please refer to the below description for how to 

select the "Return Mode" and "Return Time".
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 For detailed description of how to set the Return Mode and Second, please see "TR-102 GPRS Access command Vx.x.pdf" in the 

CD-ROM under the "Manual" folder.

 When you turn on the TR-102, it will resume to the previous "Return Mode" status as it was turned off.

Return 
Mode

Return Time 
(second)

description

Immediate 
report

N/A When TR-102 receives this command, it will send the report back immediately. It 
will send one or two times, and the GPRS connection is still on.
While TR-102 is in the "immediate report" mode, blue LED will flash once per 
second; and it begins to start GPS function with green LED flashing. When 
position is fixed, green LED will be on until it gets the next report request.

Period report 5 ~ 86400 
seconds

When TR-102 receives this command, it will send back the report every specified 
second. And the GPRS connection is still on. 
When the specified period of time is reached, TR102 will start GPS function with 
green LED flashing. When position is fixed, LED will be on until the time period is 
reached again; it will repeat the same procedure.
The time error of return could be 1~3 seconds, or larger if the GPRS connection 
is not stable.

Stop connect N/A When TR-102 receives this command, it will disconnect from GRPS and go to 
sleep mode.

Stop connect 
and set 
period report

30 ~ 86400 
seconds

When TR-102 receives this command, it will send the report back immediately 
by starting the GPS function with green LED flashing. When position is fixed, 
green LED is on and the GPRS connection is set for the data transferring with 
blue LED flash once per second. After that, it will disconnect from GRPS and go 
to sleep mode with green LED goes out and blue LED comes back to standby 
mode. When the specified period of time is reached, it will wake up and connect 
to internet via GPRS to send the report, and go to sleep mode again. It will repeat 
the same procedure when the specified period time is reached again.
Due to the GPS function is closed most of time, when it starts the GPS function, it 
could take a little bit longer to get a fixed position. If the GPS signal is not strong 
enough, it could take more than 3 minutes (also depending on the stability of 
GPRS connection.) 
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9.4 TR-102 sends back location information to Call Center

•  When TR-102 receives a command, it will send back the location information by GPRS. Please switch 
to GPRS view in the Call Center program and you can see the most updated information is displayed 
in the top of the list.
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9.5 Displaying the location on map

● 	Click on Map from menu bar, you can setup the 
program to display the map by "Google Map" or 
"Google Earth".  

● 	If  you have checked the View > Show Map, the 
Call Center program will make the "Google Map" or 
"Google Earth" to refresh the display when receiving 
the updated information.

● 	Or you can double click on any item, it will also show 
the location map on "Google Map" or "Google Earth".
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10. How does TR-102 work by SMS and GRPS?
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Mobile Phone Call Answer
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Figure. 1

Figure. 2
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Mobile Phone

TR-102

When SOS button 
is pressed.

SMS

Emergency Report:
TR102
2005/01/02 11:20:30
24.9965,121.4877
GPS fixed

SOS number 1

SOS number 2

SOS number 3

example

Mobile Phone TR-102

When Quick Dial 
button is pressed.

Quick Dial number

Call
Answer

Figure. 4

Figure. 5
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status cause solution
After you turn on the power of 
TR-102, the three LEDs are 
flashing simultaneously.

The SIM card is not 
inserted.

Please insert the SIM card into TR-102.

The SIM card is 
inserted in the TR-
102, but it has the 
PIN code protection 
enabled and the PIN 
code is mismatched.

Please take out the SIM card, use your mobile 
phone to disable the PIN code protection and then 
insert the SIM card back to TR-102. Then you will 
not be asked the PIN code in the Setup mode.
Or connect the TR-102 to PC and enter the setup 
mode of Call Center program to input the correct 
password.

After you turn on the power of 
TR-102, the Blue GSM LED is  on.

The signal is too 
weak.

Please move to a location where there is a 
stronger signal.

► For more information about the Google Earth software and Free DDNS Service, please refer to "TR-101 
Supporting User Manual EN1_Free DDNS Service.pdf" and "TR-101 Supporting User Manual En_Free Google 
Earth Software.pdf" which you can find them in the CD-ROM under the "Manual" folder.

► In general situation, it needs about 4 ~ 5 hours to fully charge the battery under the power-off condition.  If you 
charge the battery under the power-on condition, it may need longer charging time depending on different usage 
mode.

► There is a little tenon on the rubber cover of TR-102 USB port (please see the right figure). You 
have to press it a little harder downward to close it firmly. There will be a click sound if you do 
the right way. 

► Please do not connect TR-102 to AC power adapter during its startup process, otherwise it can 
not be turned on properly.

► Please do not connect TR-102 to a USB cable when you are changing the battery, otherwise it 
will make some beep sound.

► If TR-102 can not be turned off properly, please open the battery cover and remove the battery for 3 seconds at 
least. Put the battery back and then restart it.  

11. Troubleshooting and Safety info
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► When you press the KML button, only the 
item with GPS fixed (2D or 3D) will be 
exported.  If all the items are "No Fix", 
then it can not be exported to the KML 
file, and you will see the error message 
with "No effective data". 

►	 When the device is turned on, it will begin to do the initialization process, and you will hear a short “toot” sound from 
the speaker. This is a normal situation, not a defect.

►	 Please avoid storing the device in an excessive heat or humidity place.  Please do not leave the device in your car 
under the direct sunshine with windows closed.  A high temperature environment may damage the device or even 
cause the battery explosion.

►	 When you use TR-102 to make a call, but the other party can not be reached for some reason (not turn on, busy 
line, reject the call), you may hear the voice that requests you to leave a message in the voice box. If you don't want 
to leave a message, please make sure to press the hang up button on TR-102 to end the call, otherwise TR-102 
will keep hanging on with the voice box system and can not come back to standby mode.    

►	 Do not hold TR-102 to your ear when it rings! When you receive a call, press the answer button to accept the call 
before bringing TR-102 to your ear in order to avoid ear damage caused by the loud ringtones. 
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FCC Regulations: 

•   This mobile phone complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

•   This mobile phone has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can radiat-
ed radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one or more of the following measures:

-Reorient or relocate the receiving antenna.
-Increase the separation between the equipment and receiver.
-Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
-Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for compliance could void the 
user‘s authority to operate the equipment.

RF Exposure Information (SAR) 

This model phone meets the government’s requirements for exposure to radio waves.
This phone is designed and manufactured not to exceed the emission limits for exposure to radio fre-
quency (RF) energy set by the Federal Communications Commission of the U.S. Government.  

The exposure standard for wireless mobile phones employs a unit of measurement known as the Spe-
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cific Absorption Rate, or SAR.  The SAR limit set by the FCC is 1.6W/kg.  *Tests for SAR are conducted 
using standard operating positions accepted by the FCC with the phone transmitting at its highest certi-
fied power level in all tested frequency bands.  Although the SAR is determined at the highest certified 
power level, the actual SAR level of the phone while operating can be well below the maximum value.  
This is because the phone is designed to operate at multiple power levels so as to use only the poser 
required to reach the network.  In general, the closer you are to a wireless base station antenna, the 
lower the power output.

The highest SAR value for the model phone as reported to the FCC when tested for use at the ear is 
0.758 W/kg for GSM850 / 0.735 W/kg for PCS1900 and when worn on the body, as described in this 
user guide, is 0.21 W/kg for GSM850 / 0.223 W/kg for PCS1900  (Body-worn measurements differ 
among phone models, depending upon available enhancements and FCC requirements.)

While there may be differences between the SAR levels of various phones and at various positions, they 
all meet the government requirement.

The FCC has granted an Equipment Authorization for this model phone with all reported SAR levels 
evaluated as in compliance with the FCC RF exposure guidelines.  SAR information on this model 
phone is on file with the FCC and can be found under the Display Grant section of http://www.fcc.gov/
oet/fccid after searching on FCC ID: RID-TR101.

For body worn operation, this phone has been tested and meets the FCC RF exposure guidelines for 
use with an accessory that contains no metal and the positions the handset a minimum of 1.5 cm from 
the body.  Use of other enhancements may not ensure compliance with FCC RF exposure guidelines.  If 
you do no t use a body-worn accessory and are not holding the phone at the ear, position the handset a 
minimum of 1.5 cm from your body when the phone is switched on.


